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• For safety and warning information, please read this 
manual before attempting to use the equipment. 

• Additional safety and warning information is provided 
within the MG3700A Vector Signal Generator 
Operation Manual (Mainframe), or MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe). Please also refer to 
either of these documents before using the 
equipment. 

• Keep this manual with the equipment. 
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Safety Symbols 
To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu Corporation uses the 
following safety symbols to indicate safety-related information.  Ensure that you clearly understand the meanings 
of the symbols BEFORE using the equipment.  Some or all of the following symbols may be used on all Anritsu 
equipment.  In addition, there may be other labels attached to products that are not shown in the diagrams in this 
manual. 
 

Symbols used in manual 
This indicates a very dangerous procedure that could result in serious injury or 
death if not performed properly. 
 

This indicates a hazardous procedure that could result in serious injury or death if 
not performed properly. 
 
This indicates a hazardous procedure or danger that could result in light-to-severe 
injury, or loss related to equipment malfunction, if proper precautions are not taken. 

 

Safety Symbols Used on Equipment and in Manual 
The following safety symbols are used inside or on the equipment near operation locations to provide information 
about safety items and operation precautions.  Ensure that you clearly understand the meanings of the symbols 
and take the necessary precautions BEFORE using the equipment. 
 
 

 
This indicates a prohibited operation.  The prohibited operation is indicated 
symbolically in or near the barred circle. 

 
  This indicates an obligatory safety precaution.  The obligatory operation is 

indicated symbolically in or near the circle. 
 
  This indicates a warning or caution.  The contents are indicated symbolically in or 

near the triangle. 
 
  This indicates a note.  The contents are described in the box. 
 
 
  These indicate that the marked part should be recycled. 

 

MX370106A 
DVB-T/H IQproducerTM  
Operation Manual 
 
27 June 2006 (First Edition) 
23 October 2012 (Fifth Edition) 
 
Copyright © 2006-2012, ANRITSU CORPORATION. 
All rights reserved.  No part of this manual may be reproduced without the prior written permission of the 
publisher. 
The contents of this manual may be changed without prior notice. 
Printed in Japan 

 DANGER 

 WARNING 

 CAUTION 
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Equipment Certificate 
Anritsu Corporation guarantees that this equipment was inspected at 
shipment and meets the published specifications. 
 
 

Anritsu Warranty 
• During the warranty period, Anritsu Corporation will repair or exchange this 

software free-of-charge if it proves defective when used as described in the 
operation manual. 

• The warranty period is 6 months from the purchase date. 
• The warranty period after repair or exchange will remain 6 months from 

the original purchase date, or 30 days from the date of repair or 
exchange, depending on whichever is longer. 

• This warranty does not cover damage to this software caused by Acts of 
God, natural disasters, and misuse or mishandling by the customer. 

 
In addition, this warranty is valid only for the original equipment purchaser. It 
is not transferable if the equipment is resold. 
 
Anritsu Corporation shall assume no liability for injury or financial loss of the 
customer due to the use of or a failure to be able to use this equipment. 
 
 

Anritsu Corporation Contact 
In the event that this equipment malfunctions, contact an Anritsu Service and 
Sales office. Contact information can be found on the last page of the printed 
version of this manual, and is available in a separate file on the CD version. 
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Notes On Export Management 
This product and its manuals may require an Export License/Approval by 
the Government of the product's country of origin for re-export from your 
country. 
Before re-exporting the product or manuals, please contact us to confirm 
whether they are export-controlled items or not. 
When you dispose of export-controlled items, the products/manuals need 
to be broken/shredded so as not to be unlawfully used for military purpose. 
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Software End-User License Agreement (EULA) 
Please read this Software End-User License Agreement (hereafter this EULA) carefully before using 
(includes executing, copying, registering, etc.) this software (includes programs, databases, scenarios, 
etc., used to operate, set, etc., Anritsu electronic equipment). By reading this EULA and using this 
software, you are agreeing to be bound by the terms of its contents and Anritsu Corporation (hereafter 
Anritsu) hereby grants you the right to use this Software with the Anritsu-specified equipment 
(hereafter Equipment) for the purposes set out in this EULA. 
 
1. Grant of License and Limitations 

1. Regardless of whether this Software was 
purchased from or provided free-of-charge by 
Anritsu, you agree not to rent, lease, lend, or 
otherwise distribute this Software to third 
parties and further agree not to disassemble, 
recompile, reverse engineer, modify, or create 
derivative works of this Software. 

2. You may make one copy of this Software for 
backup purposes only. 

3. You are not permitted to reverse engineer 
this software. 

4. This EULA allows you to install one copy of 
this Software on one piece of Equipment.  

2. Disclaimers 
 To the extent not prohibited by law, in no 

event shall Anritsu be liable for personal 
injury, or any incidental, special, indirect or 
consequential damages whatsoever, 
including, without limitation, damages for 
loss of profits, loss of data, business 
interruption or any other commercial 
damages or losses, arising out of or related 
to your use or inability to use this Software. 

 
 

3. Limitation of Liability 
a. If a fault (bug) is discovered in this Software, 

preventing operation as described in the 
operation manual or specifications whether 
or not the customer uses this software as 
described in the manual, Anritsu shall at its 
own discretion, fix the bug, or exchange the 
software, or suggest a workaround, 
free-of-charge. However, notwithstanding 
the above, the following items shall be 
excluded from repair and warranty.  

i) If this Software is deemed to be used for 
purposes not described in the operation 
manual or specifications. 

ii) If this Software is used in conjunction with 
other non-Anritsu-approved software. 

iii) Recovery of lost or damaged data. 
iv) If this Software or the Equipment has been 

modified, repaired, or otherwise altered 
without Anritsu's prior approval. 

v) For any other reasons out of Anritsu's direct 
control and responsibility, such as but not 
limited to, natural disasters, software virus 
infections, etc. 

b. Expenses incurred for transport, hotel, daily 
allowance, etc., for on-site repairs by Anritsu 
engineers necessitated by the above faults 
shall be borne by you. 

c. The warranty period for faults listed in 
article 3a above covered by this EULA shall 
be either 6 months from the date of purchase 
of this Software or 30 days after the date of 
repair, whichever is longer. 
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4. Export Restrictions 
 You may not use or otherwise export or 

re-export directly or indirectly this Software 
except as authorized by Japanese and 
United States law. In particular, this 
software may not be exported or re-exported 
(a) into any Japanese or US embargoed 
countries or (b) to anyone on the Japanese or 
US Treasury Department's list of Specially 
Designated Nationals or the US Department 
of Commerce Denied Persons List or Entity 
List. By using this Software, you warrant 
that you are not located in any such country 
or on any such list. You also agree that you 
will not use this Software for any purposes 
prohibited by Japanese and US law, 
including, without limitation, the 
development, design and manufacture or 
production of missiles or nuclear, chemical or 
biological weapons of mass destruction. 

5. Termination 
 Anritsu shall deem this EULA terminated if 

you violate any conditions described herein. 
This EULA shall also be terminated if the 
conditions herein cannot be continued for 
any good reason, such as violation of 
copyrights, patents, or other laws and 
ordinances. 

6. Reparations 
 If Anritsu suffers any loss, financial or 

otherwise, due to your violation of the terms 
of this EULA, Anritsu shall have the right to 
seek proportional damages from you. 

7. Responsibility after Termination 
 Upon termination of this EULA in 

accordance with item 5, you shall cease all 
use of this Software immediately and shall 
as directed by Anritsu either destroy or 
return this Software and any backup copies, 
full or partial, to Anritsu. 

8. Dispute Resolution 
 If matters of dispute or items not covered by 

this EULA arise, they shall be resolved by 
negotiations in good faith between you and 
Anritsu. 

9. Court of Jurisdiction 
 This EULA shall be interpreted in 

accordance with Japanese law and any 
disputes that cannot be resolved by 
negotiation described in Article 8 shall be 
settled by the Japanese courts. 
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Cautions against computer virus infection 
• Copying files and data 
 Only files that have been provided directly from Anritsu or generated 

using Anritsu equipment should be copied to the instrument. 
 All other required files should be transferred by means of USB or 

CompactFlash media after undergoing a thorough virus check. 
• Adding software 
 Do not download or install software that has not been specifically 

recommended or licensed by Anritsu.  
• Network connections 
 Ensure that the network has sufficient anti-virus security protection in 

place. 
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CE Conformity Marking 
Anritsu affixes the CE conformity marking on the following product(s) in 
accordance with the Council Directive 93/68/EEC to indicate that they 
conform to the EMC and LVD directive of the European Union (EU). 
 

CE marking 

 

1. Product Model 
Software: MX370106A DVB-T/H IQproducerTM 

 
2. Applied Directive and Standards 
 When the MX370106A DVB-T/H IQproducerTM is installed in the 

MG3710A, the applied directive and standards of this software conform to 
those of the MG3710A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370106A can be used with. 
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C-tick Conformity Marking 
Anritsu affixes the C-tick mark on the following product(s) in accordance with 
the regulation to indicate that they conform to the EMC framework of 
Australia/New Zealand. 
 

C-tick marking 

 

 
1. Product Model 

Software: MX370106A DVB-T/H IQproducerTM 
 
2. Applied Directive and Standards 
 When the MX370106A DVB-T/H IQproducerTM is installed in the 

MG3710A, the applied directive and standards of this software conform to 
those of the MG3710A main frame. 

 
 PS: About main frame 
 Please contact Anritsu for the latest information on the main frame 

types that MX370106A can be used with. 
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About This Manual 
■Associated Documents 

The operation manual configuration of the MX370106A DVB-T/H IQpro-
ducerTM is shown below.  

■If using MG3700A or MG3710A:  

Or 

 

MX370106A  
DVB-T/H IQproducer™ Operation Manual  

 

MG3700A /MG3710AVector Signal Generator 
MG3740A Analog Signal Generator Operation Manual (IQproducer™) 
 

MG3700A  
Vector Signal Generator  
Operation Manual (Mainframe) 
 

MG3710A Vector Signal Generator 
MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 
 

 

• MG3700A Vector Signal Generator Operation Manual (Mainframe) 
This describes basic operations, maintenance procedure, and remote 
functions of the MG3700A Vector Signal Generator.  

 Or 
• MG3710A Vector Signal Generator MG3740A Analog Signal Generator 

Operation Manual (Mainframe) 
This describes basic operations, maintenance procedure, and remote 
functions of the MG3710A Vector Signal Generator and the MG3740A 
Analog Signal Generator.  
 
• MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 

Generator Operation Manual (IQproducer™) 
This describes the functions and how to use the IQproducer, which is 
Windows software for the Vector Signal Generator and the Analog Signal 
Generator.. 
 
• DVB-T/H IQproducer™ Operation Manual (This document) 
This describes basic operations and functions of the DVB-T/H IQproduc-
erTM.  
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This chapter provides an overview of the MX370106A DVB-T/H 
IQproducer 

 

1.1 Product overview .......................................................... 1-2 
1.2 Product Composition .................................................... 1-3 
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1.1 Product overview 
MX370106A DVB-T/H IQproducer (hereinafter referred to as “this 
software”) is software used to generate waveform patterns conforming to 
the ETSI EN 300 744 V1.5.1 (2004-11) standard physical layers 
specifications.  

This software requires either of the following environment: 

• MG3710A Vector Signal Generator 
• Personal computer (hereinafter, “PC”) 
 
This software generates waveform patterns that support the 
specifications of ETSI EN 300 744 V1.5.1 (2004-11) with various 
characteristics. This is made possible by the editing/customizing of 
parameters according to its use.  

A waveform pattern created by this software can be output using an RF 
signal after being downloaded into the MG3700A Vector Signal Generator, 
or MG3710A Vector Signal Generator (collectively referred to as 
“mainframe”, or “this equipment”). 



 

1.2 Product Composition 

1-3 

1 

O
verview

 

1.2 Product Composition 
The following table lists the model name and specifications of this 
software according to the equipment. 

Table 1.2-1  Restrictions 

Mainframe 

 

Restrictions 

MG3700A MG3710A 

Software name MX370106A 

Maximum Size 
of Waveform 
Patterns 

256 M sample 
512 M sample*1 

64 M sample 
128 M sample*3 
256 M sample*4 
512 M sample*５ 

Transmission 
method of 
Waveform 
Patterns 

LAN, 
CompactFlash 
Card 

External device 
such as LAN, 
USB memory*2 

Installation of 
this software 
to this 
equipment 

N/A Possible  

 
*1: The ARB memory expansion 512M sample (optional) must be 

installed into the MG3700A to use waveform patterns that exceed 
256 M samples. 

*2: Transferring waveform patterns is not required if the waveform 
patterns are created on the equipment using this software. 

*3: The Combination of Baseband Signal (optional) must be installed 
into the MG3710A to use waveform patterns of maximum 128 M 
samples. 

*4: The ARB memory expansion 256M sample (optional) must be 
installed into the MG3710A to use waveform patterns of maximum 
256 M samples.  

*5: To use waveform patterns of maximum 512 M samples, either of the 
following must be installed into MG3710A: 

• ARB memory expansion 1024 M sample (optional) 

• ARB memory expansion 256 M (optional) and Combination of 
Baseband Signal (optional) 
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■Notes on waveform pattern conversion 

The waveform patterns generated with this software varies according to 
the main unit type. If using the waveform pattern to the different main 
unit, you need to convert the waveform pattern.  

For details about how to convert a waveform pattern, see Section 4.5 
“File Conversion on Convert Screen” in the MG3700A/MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(IQproducerTM).  
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2 

Preparation 

This chapter describes the operating environment for the MX370106A. 

 

2.1 Operating Environment ................................................. 2-2 
2.2 Installation/Uninstallation .............................................. 2-3 
2.3 Starting up and exiting the software ............................. 2-4 

2.3.1 Starting Software: When installed on PC ......... 2-4 
2.3.3 Starting Software: When installed on  

MG3710A ......................................................... 2-7 
2.3.4 Exiting Software ................................................ 2-9 
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2.1 Operating Environment 
The following environment is required for operating the MX370106A. 

(1) PC that meets the following conditions 
OS Windows XP/Windows Vista/Windows 7 
CPU Pentium III 1 GHz equivalent or faster 
Memory 512 MB or more 

Hard disk space 

5 GB or more free space in the drive where 
this software is to be installed.  
The free hard disk space necessary to create 
waveform pattern varies depending on the 
waveform pattern size. The free disk space of 
27 GB or greater is required to create four 
maximum (512 Msample) waveform patterns. 

 
(2) If viewing on PC, displays with a resolution of 1024 × 768 pixels are 

best viewed using a small font setting. 
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2.2 Installation/Uninstallation 
This software is included in the IQproducer™ installer. It is 
automatically installed by installing the IQproducer™ that is supplied 
with this equipment or this software. When using a waveform pattern 
created using this software in the equipment, the license file must be 
installed in advance. 

■Installing/Uninstalling IQproducer™ 
Refer to section 2 “Installation/Uninstallation” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™). 

■Installing/Uninstalling IQproducer™ license file 
For how to install license file to MG3700A/MG3710A, refer to the 
following manual:  

• MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™) 
5.1 “Installing License File” 
 

For how to uninstall license file from MG3700A/MG3710A, refer to each 
one of the following manuals:  

• MG3700A Vector Signal Generator Operation Manual (Mainframe) 
3.10.10 “Install” 

• MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 
9.4.4 “Install” 
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2.3 Starting up and exiting the software 
This section explains how to start and stop this software. 

Note: 
The following explanation assumes the use of Windows XP. The 
screen image may differ slightly if not using Windows XP.  

 

2.3.1 Starting Software: When installed on PC 
Start this software using the following procedure.  
The example assumes that it is a PC operation.  

<Procedure> 
1. Click Start on the task bar, and point to All Programs. Next, point to 

Anritsu Corporation, point to IQproducer, and then click 
IQproducer. 

 

Figure 2.3.1-1  Program selection screen  
 

2. When IQproducer™ starts, the Select instrument screen is 
displayed. 
This Select instrument screen is used to select either MG3700A, or 
MG3710A. This following explanation assumes that you have 
selected MG3700.  
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Figure 2.3.1-2  Select Instrument Screen 
 

Notes: 
• This software does not support MS269xA，MS2830A，and 

MG3740A. 

• To hide this screen and to start with the selected mainframe's 
screen from the next time, select the Don't show this window 
next time check box. 

3. The common platform screen is displayed when OK is clicked in the 
Select instrument screen.  
The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 2.3.1-3  Common Platform Screen 
 

4. Click the System (Non-Cellular) tab on the common platform screen, 
to show the System (Non-Cellular) selection screen that supports 
each telecommunication system.  



 

Chapter 2  Preparation 

2-6 

 

Figure 2.3.1-4  System (Non-Cellular) Selection Screen 
 

5. Click DVB-T/H to display the main screen. For details of the main 
screen, refer to Chapter 3 “Detailed Description of Functions”.  

Note: 
If Change Instrument is clicked, the Select instrument screen will 
appear each time the software is loaded.  
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2.3.2 Starting Software: When installed on MG3710A 
Start this software using the following procedure.  

<Procedure> 
1. Press  on the MG3710A front panel to display the common 

platform screen.  
The common platform screen is a screen used to select each function 
of the IQproducer™.  

 

Figure 2.3.2-1  Common Platform Screen 
 

2. Click the System (Non-Cellular) tab on the common platform screen, 
to show the System (Non-Cellular) selection screen that supports 
each telecommunication system.  

 

Figure 2.3.2-2  System (Non-Cellular) Selection Screen 

3. Click DVB-T/H to display the main screen. For details of the main 
screen, refer to Chapter 3 “Detailed Description of Functions”.  
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Note: 
When this software is installed on MG3710A, Change Instrument 
displays instead of Interface Settings. Clicking Interface Settings 
displays the Interface Setting dialog box. 

 

Figure 2.3.2-3  Interface Settings Dialog Box 
 

Here, you can configure interface-related settings of IQproducer 
and MG3710A. To return to factory defaults, click Default. 

• Row Socket Port Number 
Sets Row Socket port number. Set the same value as that for 
MG3710A.  

• Wait Time 
Sets the wait time between commands.  
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2.3.3 Exiting Software 
Stop this software using the following procedure. 

■When exiting only this software 
To exit only this software without closing the Common Platform screen, 
or other IQproducer™ tools, do one of these below: 

• Click the Exit button ( ) on the tool bar. 
• Select Exit from the File menu. 
• Click the  button on the upper right screen. 
 

 

Figure 2.3.3-1  Exiting Software 
 

The operation of the three screen buttons is explained below.  

 

Figure 2.3.3-2  Exit Confirmation Window 
 

• Yes Saves current parameters to file and stops this 
software. 

• No Stops this software without saving current 
parameters to file. 

• Cancel or  Cancels the process and returns to the main screen. 
 
When stopping this software using the Yes button, the saved parameters 
are read at the next start and reset for each parameter.  

■When exiting entire IQproducer™ application 
To exit all tools of IQproducer™ that are running, select Exit on the 
Common Platform Screen. In this case, a dialog is displayed to confirm 
stopping of each running tool.  
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Figure 2.3.3-3  Exiting IQproducer™ 
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This chapter provides detailed descriptions of this software. 

Notes: 

 The examples and screens used throughout this chapter are 
based on the assumption that the IQproducer™ is activated 
with the MG3700A.  

 The MG3710A functions are described as notes in each item. 

 

3.1 Composition of Setting Dialog Box ............................... 3-2 
3.1.1 Menus and tool buttons .................................... 3-3 
3.1.2 Parameter details ............................................. 3-8 
3.1.3 Exporting waveform pattern ........................... 3-16 
3.1.4 Calculation screen .......................................... 3-18 
3.1.5 Calculation & Load ......................................... 3-19 
3.1.6 Calculation & Play .......................................... 3-20 
3.1.7 Saving/loading parameters ............................. 3-21 
3.1.8 Displaying graph ............................................. 3-24 
3.1.9 Outputting auxiliary signal .............................. 3-28 

3.2 Waveform Pattern Generating Procedure .................. 3-29 
3.3 Functional Block for Generating DVB Signals ............ 3-30 
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3.1 Composition of Setting Dialog Box 
On common platform screen, select the System (Non-Cellular) tab, and 
then select DVB-T/H to display the setting dialog box. 

Parameters 

Tool buttons

Menus

 

Figure 3.1-1  DVB-T/H setting dialog box 

 



 

3.1 Composition of Setting Dialog Box 

3-3 

3 

D
etailed D

escription
 of F

u
n

ction
s 

3.1.1 Menus and tool buttons 
The menus and tool buttons on the DVB-T/H setting dialog box are 
described in detail below. 

■ The [File] menu contains the following menu items. 

 

Figure 3.1.1-1  Menu items in File menu 

 

 Select Option 
■ When using MG3700A 

 Select whether the ARB memory expansion option 256Msamples is 
installed. Selecting With Option21 (Memory 512M samples) 
supports creation of larger waveform patterns. If the ARB memory 
expansion option is not installed, the generated waveform pattern 
may not be able to be used. Waveform patterns cannot be created 
with a size greater than 256Msamples when Without Option21 
(Memory 512M samples) is selected. Select either according to the 
presence of ARB memory expansion option. 

Table 3.1.1-1  Available Options for MG3700A  

Items ARB Memory Expansion 

With Option21 (Memory 512M 
samples) 1 GB x 2 memory 

Without Option21 (Memory 
512M samples): 512 MB × 2 Memories 

  

 ■ When using MG3710A 

 The presence/absence of the ARB Memory Expansion (option) and 
Baseband Signal Combination Function (option) is selected. 
Selecting the ARB Memory Expansion (option) and the Baseband 
Signal Combination Function (option) generates a bigger waveform 
pattern, while selecting the Baseband Signal Combination Function 
(option) generates a waveform pattern. If an uninstalled option is 
selected, sometimes the created waveform pattern may not be 
usable.  

 Set the combination of installed options based on the following 
setting items.  
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Table 3.1.1-2  Available Options for MG3710A 

Items Combinations of Options 

Memory 64M samples None 

Memory 64M samples × 2 
Option48 
and 
Option 78 

Memory 256M samples 
Option45 
or 
Option 75 

Memory 256M samples × 2 
Option 45 and Option 48 
or 
Option 75 and Option 78 

Memory 1024M samples 
Option46 
or 
Option 76 

Memory 1024M samples × 2 
Option 46 and Option 48 
or 
Option 76 and Option 78 

 

The maximum size of the generated waveform pattern for each of 
the setting items is shown below.  

Table 3.1.1-3  Waveform Pattern Maximum Size 

Items Maximum Size 

Memory 64M samples 64M samples 
Memory 64M samples × 2 (With 
Option48, 78) 128M samples 

Memory 256M samples 256M samples 
Memory 256M samples × 2 (With 
Option48, 78) 512M samples 

Memory 1024M samples 512M samples 
Memory 1024M samples × 2 (With 
Option48, 78) 512M samples 

 

 Recall Parameter File 

Loads the parameter files saved by the [Save Parameter File] menu.  
Loading and using a parameter file facilitates parameter setting. 

 

 Save Parameter File 

Saves setting parameters to a file. 
 

 Exit 

Exits from this software. 
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■ The [Transfer &Setting] menu contains the following menu item. 

 

Figure 3.1.1-2  Menu item in Transfer Setting menu 

 

 Transfer & Setting Wizard 

Displays the Transfer & Setting Wizard window. In this window, a 
series of operations, including connection between a PC and the 
MG3700A/MG3710A, waveform pattern transfer to the 
MG3700A/MG3710A internal hard disk, and waveform pattern 
loading from the hard disk to an arbitrary waveform memory are 
performed. 

 

■ The [Simulation] menu contains the following menu items. 

 

Figure 3.1.1-3  Menu items in Simulation menu 

 

 CCDF 

Displays the CCDF Graph Monitor window. In this window, the 
CCDF of a generated waveform pattern is displayed in a graph. 

 

 FFT 

Displays the FFT Graph Monitor window. In this window, the 
FFT-processed spectrum of a generated waveform pattern is 
displayed in a graph. 
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■ The [Edit] menu contains the following menu item. 

 

Figure 3.1.1-4  Menu items in Edit menu 

 

 Calculation 
Generates a waveform pattern after parameters are set. 

 Calculation & Load  

Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded into the MG3710A waveform memory.  

 Calculation & Play  

Note: 

This function is available only when this software is used on 
MG3710A. 

After waveform generation is finished, the created waveform 
pattern is loaded and selected at the MG3710A waveform memory.  
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■ The Tool buttons contains the following menu item. 
Note: 

Calculation & Load and Calculation & Play are available 
only when this software is used on MG3710A. 

 

  Recall Parameter File 

  Save Parameter File 

  Calculation 

  Calculation & Load 

  Calculation & Play 

 Transfer & Setting Wizard 

  CCDF 

  FFT 

  Exit 

 

Clicking a tool button operates the same as the corresponding 
commands in the menu.  
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3.1.2 Parameter details 
The parameters on the DVB-T/H setting dialog box are described in 
detail below. 

System 

[Function] Sets the system. 
[Default] DVB-H 
[Setting range] DVB-T, DVB-H 
[Remarks] Parameter setting is restricted as follows when DVB-T is 

selected. 
Mode: 4K cannot be set. 
Bandwidth: 5 MHz cannot be set. 
In-depth Symbol Interleaver: Disabled (fixed to OFF). 
MPE-FEC: Disabled (fixed to OFF). 
Time Slicing: Disabled (fixed to OFF). 

 
Parameter setting is restricted as follows when DVB-H is 
selected. 
User Cell ID: Fixed to ON. 

 
Transmission 

[Function] Sets the hierarchy setting. 
[Default] Non-hierarchical 
[Setting range] Non-hierarchical, Hierarchical 
[Remarks] Parameter settings are restricted as follows when 

Non-hierarchical is selected. 
Alpha: Disabled for 2, 4 

(fixed to 1). 
Data Pattern: Disabled for LP. 
Outer Coder: Disabled for LP. 
Outer Interleaver: Disabled for LP. 
Inner Coder: Disabled for LP. 
Code Rate: Disabled for LP. 
Time Slicing: Disabled for LP. 
MPE-FEC: Disabled for LP. 

 
Parameter setting is restricted as follows when 
Hierarchical is selected. 
Modulation Type: Cannot be set to QPSK. 
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Alpha 

[Function] Sets the value of . 
[Default] 1 

[Setting range] 1, 2, 4 
[Remarks]  

 
Mode 

[Function] Sets the number of OFDM subcarriers. 
[Default] 2K 

[Setting range] 2K, 4K, 8K 

[Remarks] Parameter setting is restricted as follows when 8 K is set. 
In-depth Symbol Interleaver: Disabled (fixed to OFF). 

 
Bandwidth 

[Function] Sets the bandwidth. 
[Default] 8MHz 

[Setting range] 5MHz, 6MHz, 7MHz, 8MHz 

[Remarks]  

 
Modulation Type 

[Function] Selects the modulation type. 
[Default] 16QAM 
[Setting range] QPSK, 16QAM, 64QAM 
[Remarks]  

 
Guard Interval 

[Function] Selects the guard interval. 
[Default] 1/4 
[Setting range] 1/4, 1/8, 1/16, 1/32 
[Remarks]  

 
User Cell ID 

[Function] Sets the cell ID. 
[Default] ON (0000) 
[Setting range] ON (0000 to FFFF), OFF 
[Remarks] Set the cell ID in hexadecimal format. 
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Outer Coder 

[Function] Sets the Outer Coder. 
[Default] ON (for HP), OFF (for LP) 
[Setting range] ON, OFF 
[Remarks] This parameter is always set to OFF when Outer 

Interleaver is set to OFF. 
When Transmission is set to Hierarchical, the Outer 
Coder setting for HP applies to that for LP, and vice versa. 
 

Outer Interleaver 

[Function] Sets the Outer Interleaver. 
[Default] ON (for HP), OFF (for LP) 
[Setting range] ON, OFF 
[Remarks] This parameter is always set to OFF when Inner 

Interleaver is set to OFF. 
This parameter is always set to ON when Outer Coder is 
set to ON. 
When Transmission is set to Hierarchical, the Outer 
Interleaver setting for HP applies to that for LP, and vice 
versa. 
 

Inner Coder 

[Function] Sets the Inner Coder. 
[Default] ON (for HP), OFF (for LP) 
[Setting range] ON, OFF 
[Remarks] This parameter is always set to OFF when Inner 

Interleaver is set to OFF. 
This parameter is always set to ON when Outer 
Interleaver is set to ON. 
When Transmission is set to Hierarchical, the Inner 
Coder setting for HP applies to that for LP, and vice 
versa. 
Code Rate is disabled when this parameter is set to OFF. 
 

Code Rate 

[Function] Selects the encoding ratio. 
[Default] 1/2 (for both HP and LP) 
[Setting range] 1/2, 2/3, 3/4, 5/6, 7/8 
[Remarks]  
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Inner Interleaver 

[Function] Sets the Inner Interleaver. 
[Default] ON 
[Setting range] ON, OFF 
[Remarks] This parameter is always set to ON when Inner Coder is 

set to ON. 
The following restriction applies when set to OFF: 
In-depth Symbol Interleaver is disabled (fixed to OFF). 
 

Data Pattern 

[Function] Selects the data pattern. 
[Default] PN9 (for both HP and LP) 
[Setting range] PN9, PN15, PN23, ALL0, ALL1, 0101, Null TS, TS File 
[Remarks] When this parameter is set to Null TS or TS File for HP 

or LP, be sure to apply the same setting for the other (LP 
or HP). 
When setting a pattern other than Null TS and TS File 
(PN9, PN15, PN23, ALL0, ALL1, and 0101), any 
combination can be set between HP and LP. 
When TS File is selected, a created TS (Transport 
Stream: binary data in which image data and voice data 
are multiplexed) data file can be loaded. Click the Browse 
button on the right of the TS File radio button to select a 
file to be loaded. 
TS data consists of two or more packets (1 packet = 188 
bytes). The first byte of each packet is the Sync Byte, and 
is always 47 (hexadecimal). If a file that does not satisfy 
this TS data format is selected and the Calculation button 
( ) is clicked, an error message will be displayed. 
The Sync Byte is also added to PN9, PN15, PN23, ALL0, 
ALL1, and 0101 data patterns when Outer Coder, Outer 
Interleaver, Inner Coder, and Inner Interleaver are all set 
to ON. At this time, the last data in a packet and the data 
following the Sync Byte in the next packet are continuous 
as shown in Figure 3.1.2-1 below. 

 

188 bytes 188 bytes 

indicates Sync Byte 

Continuous

 

Figure 3.1.2-1  Continuity between packets 
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Number of Super Frames 

[Function] Sets the number of super frames. 
[Default] 1 
[Setting range] 1 to 384 
[Remarks] The setting range varies depending on the Select Option 

and Mode settings, as shown in the table below. 
 

Table 3.1.2-1  Maximum Number of Super Frames for MG3700A 

Select Option Mode 
Maximum Number of 

Super Frames 

With Option21 
(Memory 512Msamples) 

2K 384 
4K 192 
8K 96 

Without Option21 
(Memory 512Msamples) 

2K 192 
4K 96 
8K 48 

 
Table 3.1.2-2  Maximum Number of Super Frames for MG3710A 

Select Option Mode 
Maximum Number of 

Super Frames 

Memory 64M samples 
2K 48 
4K 24 
8K 12 

Memory 64M samples x2  
(With Option48,78) 

2K 96 
4K 48 
8K 24 

Memory 256M samples 
2K 192 
4K 96 
8K 48 

Memory 256M samples x2  
(With Option48,78) 

2K 385 
4K 192 
8K 96 

Memory 1024M samples 
2K 385 
4K 192 
8K 96 

Memory 1024M samples x2 
(With Option48,78) 

2K 385 
4K 192 
8K 96 
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The length of data selected by Data Pattern is adjusted to 
the number of super frames set by this parameter. 
When TS File is selected for Data Pattern, the data 
processing method varies depending on the set TS File 
data size and the set number of super frames. 
When the TS File data size is greater than the data size 
equivalent to the set number of super frames, the TS File 
data loading is canceled midstream. 
On the other hand, when the TS File data size is smaller, 
the same TS File data is loaded again from the beginning. 
 

 TS file = x bytes

This part of data is 
discarded. 

Super frame 1
= y bytes 

Super frame n
= y bytes 

When x > n  y

…

The begging part of data is copied. 

TS file = x bytes

Super frame 1
= y bytes 

Super frame (n1) 
= y bytes 

Super frame n
= y bytes 

When x < n  y

…

 

Figure 3.1.2-2  TS file loading 
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In-depth Symbol Interleaver 

[Function] Sets the In-depth Symbol Interleaver. 
[Default] OFF 
[Setting range] ON, OFF 
[Remarks]  

 
Time Slicing 

[Function] Sets the time slicing. 
[Default] OFF (for both HP and LP) 
[Setting range] ON, OFF 
[Remarks] The 49th bit of the TPS data is set to 1 when this 

parameter is set to ON. 
When TS File is selected for Data Pattern, be sure to 
select a TS file for which Time Slicing has been processed. 
 

MPE-FEC 

[Function] Sets the MPE-FEC. 
[Default] OFF (for both HP and LP) 
[Setting range] ON, OFF 
[Remarks] The 50th bit of the TPS data is set to 1 when this 

parameter is set to ON. 
When TS File is selected for Data Pattern, be sure to 
select a TS file for which MPE-FEC has been processed. 
 

Filter 

[Function] Selects the filter type. 
[Default] None 
[Setting range] None, Nyquist, Root Nyquist, Gaussian, Ideal Lowpass 
[Remarks] The settings of RollOff/BT and Symbol Length are invalid 

when None or Ideal Lowpass is selected. 
If the set filter greatly reduces the signal band, the 
obtained output level may be lower than the level set for 
the MG3700A/MG3710A. 
 

Roll Off/BT 

[Function] Sets the roll off rate and BT product. 
[Default] 0.100 
[Setting range] 0.100 to 1.000 
[Remarks] Set this parameter when Nyquist, Root Nyquist, or 

Gaussian is selected for Filter. 
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Symbol Length 

[Function] Sets the filter length of the filter coefficient. 
[Default] 1 
[Setting range] 1 to 1023 
[Remarks] Set this parameter when Nyquist, Root Nyquist, or 

Gaussian is selected for Filter. 
This parameter is fixed to 1 when None is selected for 
Filter, and fixed to 1023 when Ideal Lowpass is selected. 
 

Multipath 

[Function] Sets the multipath. 
[Default] OFF 
[Setting range] OFF, P1, F1 
[Remarks]  
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3.1.3 Exporting waveform pattern 
How to export a waveform pattern is described below. 

When the required parameters are set, select [Calculation] from the 
[Edit] menu or click the   tool button to display the Export File 
dialog box shown in Figure 3.1.3-1. 

 Export destination path 

Export destination 
folder selection 
button 

Package name 
input field 

Comment input field 

Export file name 
input field 

 

Figure 3.1.3-1  Export File dialog box 

 

Clicking the export destination folder selection button displays the 
Browse for Folder dialog box shown in Figure 3.1.3-2. The export 
destination folder can be selected from this screen. 

 

Figure 3.1.3-2  Browse for Folder dialog box 
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When the export destination folder is not specified, waveform pattern 
files are saved in the following directory: 
X:\IQproducer\DVB-T_H\Data 
(“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed.) 

Only 1-byte alphanumeric characters and the following symbols can be 
used for package names and file names. 
! % & ( ) + = ‘ { } _ - ^ @ [ ] 

The text input in the comment input field will be displayed in the 
Comment field on the MG3700A/MG3710A window. The comment input 
field can also be left blank. 

All the parameters except for comments are mandatory. Confirm that all 
the necessary parameters are set, and then click the [OK] button to start 
waveform pattern generation. 
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3.1.4 Calculation screen 
Clicking Calculation & Load, Calculation & Play, or the OK button on 
the Export File dialog box will start the waveform generation.  

The Calculation screen is displayed while a waveform pattern is being 
generated. On this screen, the progress bar is displayed indicating the 
generation process of the waveform pattern and the progress of the 
waveform pattern generation. The generation of the waveform pattern 
can be stopped by clicking Cancel. When cancelled, it returns to the main 
screen.  

 

Progress report

Progress bar

Cancel button
 

Figure 3.1.4-1  Calculation Screen (In Progress) 

 

After waveform pattern generation is finished, the message “Calculation 
Completed.” is displayed in the progress window and the Cancel button 
changes to the OK button.  

When the generation is complete, you can return to the setting screen by 
clicking the OK button. After waveform generation, two files with .wvi 
and .wvd extension are output. 
 
If the data exceeds the maximum waveform amplitude value (8191), the 
excess data is clipped. If this happens, the message “Clipping was done.” 
is shown at the completion of calculation. 

 

 

 

Figure 3.1.4-2  Calculation Screen (Completed) 

Note: 

When using this software on MG3710A, and selecting Calculation 
& Load or Calculation & Play, the waveform generation ends 
without displaying the above screen.  
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3.1.5 Calculation & Load 
Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Load is selected, the Load Setting screen will 
display after waveform generation.  

Button for selecting load destination 

 

 

Figure 3.1.5-1  Load Setting Screen 

 

The Select Memory screen will display after clicking the load destination 
in the Load Setting screen.  

 

Figure 3.1.5-2  Select Memory Screen 

After selecting the load destination of generated waveform in the Select 
Memory screen and clicking the OK button, the Load Setting screen will 
be shown again. Click the OK button in the Load Setting screen, and 
then the loading of waveform starts.  

Note: 

To exit this screen without loading the waveform pattern, click the 
Cancel button in the Load Setting screen.  
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3.1.6 Calculation & Play 
Note: 

This function is available only when this software is used on 
MG3710A.  

When Calculation & Play is selected, after waveform creation is 
completed, the created waveform is loaded into memory, selected and 
output.  

When the 2nd Vector Signal Generator (option) is installed, the Select SG 
screen is displayed before the start of waveform generation. This screen 
is used to select the signal generator for outputting the created waveform 
pattern.  

 

Figure 3.1.6-1  Select SG Screen 
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3.1.7 Saving/loading parameters 
Numeric values and settings for parameters can be saved into a 
parameter file by using this software. 

Saving a parameter file 

When running on PC 

1. Select [Save Parameter File] from the [File] menu or click the   
tool button to display the Save As dialog box. 

 

Figure 3.1.7-1  Parameter file save dialog box (Save As) 

 

2. Specify the file saving destination folder in the [Save in] field and 
enter a file name into the [File name] text box. Next, click the [Save] 
button to save the parameter file. 

 When the file saving destination folder is not selected, the 
parameter file is named in the format specified file name.xml, and 
saved into the following folder. 
X:\IQproducer\DVB-T_H\ 
“X:\IQproducer” indicates the folder where the IQproducerTM is 
installed. 

When running on MG3710A 

1. Click the [Save Parameter File] button in [File] menu or click the 

  button to display the parameter file saving screen.  
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Figure 3.1.7-2  Parameter file save dialog box (Save As) (MG3710A) 

 

2. Select the folder to store the file in the [Directories] field, and then 
enter the name of the file using the [File Name] box. Click [OK] to 
save the parameter file.  
To initialize the setting in the [Directories] field, click the [Default 

Root] button. 
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Loading a parameter file 

When running on PC  

1. Select [Recall Parameter File] from the [File] menu or click the 

  tool button to display the Open dialog box. 

 

Figure 3.1.7-3  Parameter file loading dialog box (Open) 

 

2. Click a parameter file to be loaded into the file list, and then click 
the [Open] button to load the selected parameter file. 

 
When running on MG3710A 

1. Select [Recall Parameter File] from the [File] menu or click the 
 tool button to display the parameter file reading screen.  

 

Figure 3.1.7-4  Parameter file loading dialog box (Open) (MG3710A) 

 

2. Select the directory where the files to be loaded is stored in the 
[Directories] field. Click the desired file from the [File List], and 
click [OK]. To initialize the setting in the [Directories] field, click the 
[Default Root] button. 
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3.1.8 Displaying graph 
The generated waveform pattern can be displayed in a CCDF or FFT 
graph by using this software. Refer to Sections 4.3 “CCDF Graph 
Display” and 4.4 “FFT Graph Display” in the MG3700A/MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(IQproducerTM) for details on the graph display. 

Displaying the CCDF graph 

1. Select [Calculation] from the [Edit] menu or click the   tool 
button to generate a DVB-T/H waveform pattern. 

2. Select [CCDF] from the [Simulation] menu or click the   tool 
button. The CCDF Graph Monitor window shown in Figure 3.1.8-1 is 
displayed with the trace of the generated waveform pattern. 

 

Figure 3.1.8-1  CCDF Graph Monitor window 

 

 When another waveform pattern is generated by changing 
parameters and executing “Calculation” while the previous traces 
are displayed in the CCDF Graph Monitor window, the trace of the 
waveform pattern newly generated can be displayed by either of the 
following two methods: 

 Displaying the new trace in the same window together with the 
previous trace 

 Deleting the previous traces to display the new trace 
 



 

3.1 Composition of Setting Dialog Box 

3-25 

3 

D
etailed D

escription
 of F

u
n

ction
s 

Note: 

A CCDF graph and an FFT graph cannot be generated 
simultaneously. When displaying a CCDF graph while an FFT 
graph is displayed, execute the CCDF graph generation after FFT 
graph generation has completed. 
 

 When displaying a new trace in the same window with the previous 

traces: 

1. Set [Add] for [Quick Add Mode] on the lower-left of the CCDF Graph 
Monitor window. 

2. Select [CCDF] from the [Simulation] menu or click the   tool 
button. The trace of the waveform pattern newly generated is 
additionally displayed in the CCDF Graph Monitor window. 
Up to eight traces can be displayed by repeating this procedure. 

 When deleting the previous traces to display a new trace: 

1. Set [Clear] for [Quick Add Mode] on the lower-left of the CCDF 
Graph Monitor window. 

2. Select [CCDF] from the [Simulation] menu or click the   tool 
button. At this time, the confirmation message shown in Figure 
3.1.8-2 appears: 

 

Figure 3.1.8-2  Confirmation message 

 

 Click the [Yes] button. The previous traces are then deleted from the 
CCDF Graph Monitor window, and the trace of the newly generated 
waveform pattern is displayed. 
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Displaying the FFT graph 

1. Select [Calculation] from the [Edit] menu or click the   tool 
button to generate a DVB-T/H waveform pattern. 

2. Select [FFT] from the [Simulation] menu or click the   tool 
button. The FFT Graph Monitor window shown in Figure 3.1.8-3 is 
displayed with the trace of the generated waveform pattern. 

 

Figure 3.1.8-3  FFT Graph Monitor window 

 

 When another waveform pattern is generated by changing 
parameters and executing “Calculation” while the previous traces 
are displayed in the FFT Graph Monitor window, the trace of the 
waveform pattern newly generated can be displayed by either of the 
following two methods: 

 Displaying the new trace in the same window together with the 
previous traces 

 Deleting the previous traces to display the new trace 
 

Note: 

An FFT graph and a CCDF graph cannot be generated 
simultaneously. When displaying an FFT graph while a CCDF 
graph is displayed, execute the FFT graph generation after CCDF 
graph generation has completed. 
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 When displaying a new trace in the same window with the previous 

traces: 

1. Set [Add] for [Quick Add Mode] on the lower-left of the FFT Graph 
Monitor window. 

2. Select [FFT] from the [Simulation] menu or click the   tool 
button. The trace of the waveform pattern newly generated is 
additionally displayed in the FFT Graph Monitor window. 
Up to four traces can be displayed by repeating this procedure. 

 When deleting the previous traces to display a new trace: 

1. Set [Clear] for [Quick Add Mode] on the lower-left of the FFT Graph 
Monitor window. 

2. Select [FFT] from the [Simulation] menu or click the   tool 
button. At this time, the confirmation message shown in Figure 
3.1.8-4 appears: 

 

Figure 3.1.8-4  Confirmation message 

 

 Click the [Yes] button. The previous traces are then deleted from the 
FFT Graph Monitor window, and the trace of the newly generated 
waveform pattern is displayed. 
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3.1.9 Outputting auxiliary signal 
When a waveform pattern generated by this software is selected by the 
MG3700A/MG3710A, markers synchronizing with the RF signal are 
output from the the MG3700A/MG3710A, as an auxiliary signal. 

 Super Frame Clock 
A pulse synchronizing with the first symbol of the super frame is 
output. The signal polarity can be changed by changing the polarity 
for Marker 1. 

First symbol< 1 sample

> 1 s

Super frame clock

I/Q output,
RF output

 

Figure 3.1.9-1  Super frame clock output timing 

 

The following connectors output marker signal.  
 

■ MG3700A 

Marker signal is output from the rear panel connector(s).  
 

Table 3.1.9-1  MG3700A Marker Signal 

Marker Signal  Connector 

Super Frame Clock Connector1 

 
■ MG3710A 

Marker signal is output from the rear panel connector(s).  
Output signal changes according to the MG3710A setting as below.  
 
Table 3.1.9-2  MG3710A Marker Signal 

Marker Signal  Output 
SG 

Waveform 
memory 

Signal name 

Super Frame Clock 
SG1 

Memory A SG1 Marker1 A 
Memory B SG1 Marker1 B 

SG2 
Memory A SG2 Marker1 A 
Memory B SG2 Marker1 B 

For how to configure marker signal and connector, refer to 7.4.2 “Route 
Output Connectors” in MG3710A Vector Signal Generator MG3740A 
Analog Signal Generator Operation Manual (Mainframe).  
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3.2 Waveform Pattern Generating Procedure 
The waveform pattern generation procedure is provided below, taking a 
DVB-H waveform pattern as an example. 

<Procedure> 

1. Start up the DVB-T/H IQproducerTM. 

2. Set the parameters according to the following table. 
 

Parameter Setting 

System DVB-H 
Transmission Non-hierarchical 
Alpha 1 (fixed) 
Mode 4K 
Bandwidth 7MHz 
Modulation Type 16QAM 
Guard Interval 1/32 
User Cell ID ON (fixed), FFFF 
Outer Coder ON (HP) 
Outer Interleaver ON (HP) 
Inner Coder ON (HP) 
Code Rate 7/8 (HP) 
Inner Interleaver ON 
Data Pattern Null TS (HP) 
Number of Super Frames 10 
In-depth Symbol Interleaver ON 
Time Slicing ON (HP) 
MPE-FEC ON (HP) 
Filter None 
Multipath OFF 

 
3. Select [Calculation] from the [Edit] menu or click the   tool 

button to display the Export File dialog box. 

4. Specify the file export destination folder, package name, and file 
name in the Export File dialog box. Next, click the [OK] button to 
start the waveform pattern generation. 

5. The Calculation window is then displayed. When “Calculation 
Completed” is displayed, click the [OK] button to close the 
Calculation window. 

6. Confirm that a waveform pattern file with the specified name and 
the extension “wvi” or “wvd” is generated in the folder specified in 
Step 4. 
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3.3 Functional Block for Generating DVB Signals 
This software processes DVB-T/H physical layers as shown in Figure 
3.3-1 “Signal generation block diagram” below. 
The data selected by Data Pattern is input to MPEG-TS in Figure 3.3-1 
when Outer Coder, Outer Interleaver, Inner Coder, and Inner Interleaver 
are all set to ON. 
When Outer Coder, Outer Interleaver, Inner Coder, or Inner Interleaver 
is set to OFF, the parameters prior to that are automatically set to OFF. 
In this event, the data selected by Data Pattern is input to the 
corresponding position in Figure 3.3-1 as follows, according to the 
parameter set to OFF. 

 When Outer Coder is set to OFF: A 

 When Outer Interleaver is set to OFF: B 

 When Inner Coder is set to OFF: C 

 When Inner Interleaver is set to OFF: D 
 

 MPEG-TS “HP” 

MPEG-TS “LP” 

MUX 
adaptation 

Energy 
Dispersal 

Outer Coder
A Outer 

Interleaver
B

Inner Coder 
C 

Outer 
Interleaver Inner Coder 

MUX 
adaptation 

Energy 
Dispersal 

Outer Coder

Inner 
Interleaver

D 
Mapper 

Frame 
Adaptation OFDM 

Guard 
Interval 

Insertion

Pilots 
& 

TPS signals
 

Figure 3.3-1  Signal generation block diagram 
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The following operations are required to output a modulated signal from 
this equipment using the waveform pattern generated by this software: 

• Transferring waveform pattern to internal hard disk 
• Loading waveform patterns from the hard disk to the waveform 

memory 
• Selecting a waveform pattern to be output from this equipment 
 
This chapter explains the details of these operations. 

 

4.1 For MG3700A or MG3710A .......................................... 4-2 
4.1.1 Transferring waveform pattern to internal  

hard disk ........................................................... 4-2 
4.1.2 Loading to Waveform Memory ......................... 4-4 
4.1.3 Selecting Waveform Pattern ............................. 4-5 
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4.1 For MG3700A or MG3710A 
This section describes how to download a waveform pattern created for 
the MG3700A/MG3710A to the hard disk of the MG3700A/MG3710A and 
output the pattern.  

4.1.1 Transferring waveform pattern to internal hard disk 
The waveform pattern created with this software can be transferred to 
the internal hard disk in the following ways:  

Note: 
This operation is not necessary if you are using MG3710A and 
have generated waveform patterns on MG3710A.  

For MG3700A 
• LAN 
• CompactFlash Card 
 
For MG3710A 
• LAN 
• External device such as USB Memory 
 
■Transferring from PC via LAN (MG3700A，MG3710A) 
Two IQproducerTM tools can be used to transfer a waveform pattern to 
the MG3700A/MG3710A via a LAN.  

• Transfer & Setting Wizard 
Start this wizard by clicking the Transfer & Setting Wizard button of 
this software or by selecting Simulation & Utility tab → Transfer & 
Setting Wizard from the IQproducerTM after creating a waveform 
pattern. For details, refer to Section 4.7 “File Transfer and Loading to 
Memory Using Transfer & Setting Wizard” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog 
Signal Generator Operation Manual (IQproducer™).  
Transferring a waveform pattern to the internal hard disk of the 
MG3700A/MG3710A, loading the waveform from the hard disk to the 
waveform memory, and then outputting the waveform pattern can be 
done using this wizard.  
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• Transfer & Setting Panel 
This function is loaded by selecting Transfer & Setting Panel in the 
Simulation & Utility tab of the IQproducer™. For details, refer to 
Section 5.2 “Transferring Waveform Pattern” in the 
MG3700A/MG3710A MG3740A Analog Signal Generator Operation 
Manual IQproducer™.  
Specify the folder that contains the waveform pattern to transfer to 
the MG3700A/MG3710A in the PC-side tree of Transfer & Setting 
Panel. 
 

■Transferring using a CF card (MG3700A) 
Copy the waveform pattern (***.wvi and ***.wvd files) to be downloaded 
to the MG3700A to the root directory of a CF card.  

Insert the CF card into the card slot on the front panel of the MG3700A, 
and then copy the file to the hard disk. For details about how to use a CF 
card to transfer a waveform pattern, refer to (1) Loading waveform file in 
memory in Section 3.5.2 of the MG3700A Vector Signal Generator 
Operation Manual (Mainframe). 

■Transferring via external device such as USB memory (MG3710A) 
For details about how to transfer a waveform pattern created using this 
software to the hard disk of the MG3710A, refer to Section 7.3.6 “Copying 
external waveform pattern: Copy” in the “MG3710A Vector Signal 
Generator MG3740A Analog Signal Generator Operation Manual 
(Mainframe)”.  
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4.1.2 Loading to Waveform Memory 
To output a modulated signal using a waveform pattern, it is necessary to 
load the waveform pattern that was transferred to the internal hard disk 
of the MG3700A/MG3710A (described in Section 4.1.1 “Transferring 
waveform pattern to internal hard disk”) to the waveform memory. A 
waveform pattern can be loaded into the waveform memory in the 
following two ways. 

■Configuring using the mainframe  
A waveform pattern can be loaded into the waveform memory by using 
the instruction panel of the MG3700A/MG3710A or by using a remote 
command.  

For operation using the front panel, refer below: 

• Section 3.5.2 (1) “Loading waveform file in memory” in the MG3700A 
Vector Signal Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal 
Generator Operation Manual (Mainframe) 

• Section 7.3.4 “Loading waveform pattern: Load” in the MG3710A 
Vector Signal Generator MG3740A Analog Signal Generator 
Operation Manual (Mainframe) 

 
■Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory by using Transfer & Setting Panel, which can be opened from 
the Simulation & Utility tab. For details, refer to Section 4.6 “File 
Transfer and Loading to Memory Using Transfer & Setting Panel” in the 
MG3700A/MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (IQproducer™). 
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4.1.3 Selecting Waveform Pattern 
Select a waveform pattern to use for modulation from the waveform 
patterns loaded into the waveform memory of the MG3700A/MG3710A 
according to Section 4.1.2 “Loading to waveform memory”. A waveform 
pattern can be selected in the following two ways. 

■Configuring using the MG3700A/MG3710A 
Waveform patterns to be used for modulation can be selected by 
operating the equipment panel or by using a remote command.  

For operation using the front panel, refer below:  

• Section 3.5.2 (4) “Outputting pattern loaded in Memory A for 
modulation in Edit mode” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 
For operation using remote commands, refer below: 

• Chapter 4 “Remote Control” in the MG3700A Vector Signal Generator 
Operation Manual (Mainframe) 

• Section 7.3.5 “Selecting output waveform pattern: Select” in the 
MG3710A Vector Signal Generator MG3740A Analog Signal 
Generator Operation Manual (Mainframe) 

 

■ Using Transfer & Setting Panel of IQproducerTM 
A waveform pattern can be loaded from the LAN-connected PC to the 
memory, and also selected for modulation. This is done by using Transfer 
& Setting Panel, which can be opened from the Simulation & Utility tab. 
For details, refer to Section 4.6 “File Transfer and Loading to Memory 
Using Transfer & Setting Panel” in the MG3700A/MG3710A Vector 
Signal Generator MG3740A Analog Signal Generator Operation Manual 
(IQproducer™). 
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A list of error messages is shown below. 

Table A-1  Error messages 

Error Message Description 
The Setting value is out of range.(“Number of 
Super Frames = xxx (1 to N)”) 

The set number of super frames exceeds the set-
ting range (1 to N). 

The Setting value is out of range.(“Roll Off/BT = 
xxx (0.100 to 1.000)”) 

The set roll off rate/BT product exceeds the set-
ting range (0.100 to 1.000). 

The Setting value is out of range.(“Symbol 
Length = xxx (1 to 1023)”) 

The set symbol length exceeds the setting range 
(1 to 1023). 

Input Package Name Enter the package name. 
Input Export File Name Enter the export file name. 
Incongruency : Data Pattern 
HP and LP Data Pattern are both Null TS or both 
TS File or combinations of the rest of Data Pat-
tern. 

The set combination of data patterns is incon-
gruent. 
Allowable set combinations of data pattern set-
tings for HP and LP are both Null TS, both TS 
File, or any data patterns other than Null TS or 
TS File. 

Format Error : TS File The set TS file format is improper. 
Blank : HP/LP TS File No TS file is selected. 
Not found : TS File The specified TS file cannot be found. 
Cannot Open File The file cannot be opened. 
Cannot Read File The file cannot be read. 
Cannot Write File Data cannot be written to the file. 
Setting Value is Invalid. An invalid value is set. 

 
A list of warning messages is shown below. 

Table A-2  Warning messages 

Warning Message Description 
A Transfer wizard is already running. The transfer wizard is already running. 
Clipping was done. Clipping was executed. 
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A list of parameters is shown below. 

Table B-1  Parameter list 

Parameter Setting Range Restriction 

System DVB-T, DVB-H  

Transmission Non-hierarchical, 
Hierarchical 

 

Alpha 1, 2, 4 Cannot be set to 2 or 4 when Transmission 
is set to Non-hierarchical. 

Mode 2K, 4K, 8K Cannot be set to 4K when System is set to 
DVB-T. 

Bandwidth 5MHz, 6MHz, 7MHz, 8MHz Cannot be set to 5MHz when System is set 
to DVB-T. 

Modulation Type QPSK, 16QAM, 64QAM Cannot be set to QPSK when Transmission 
is set to Hierarchical. 

Guard Interval 1/4, 1/8, 1/16, 1/32  

User Cell ID ON（0000 to FFFF）, OFF Fixed to ON when System is set to DVB-H.

Outer Coder ON, OFF Cannot be set for LP when Transmission is 
set to Non-hierarchical. 
Fixed to OFF when Outer Interleaver is set 
to OFF. 

Outer Interleaver ON, OFF Cannot be set for LP when Transmission is 
set to Non-hierarchical. 
Fixed to ON when Outer Coder is set to 
ON. 
Fixed to OFF when Inner Coder is set to 
OFF. 

Inner Coder ON, OFF Cannot be set for LP when Transmission is 
set to Non-hierarchical. 
Fixed to ON when Outer Interleaver is set 
to ON. 
Fixed to OFF when Inner Interleaver is set 
to OFF. 

Code Rate 1/2, 2/3, 3/4, 5/6, 7/8 Cannot be set for LP when Transmission is 
set to Non-hierarchical. 
Disabled when Inner Coder is set to OFF. 

Inner Interleaver ON, OFF Fixed to ON when Inner Coder is set to ON.

Data Pattern PN9, PN15, PN23, ALL0, 
ALL1, 0101, Null TS, TS 
File 

Cannot be set for LP when Transmission is 
set to Non-hierarchical. 
When Null TS or TS File is set for HP or 
LP, the same setting must be applied to the 
other one (LP or HP).  When data patterns 
other than Null TS or TS File are set, any 
set combinations including those other tan 
Null TS and/or TS File are available for HP 
and LP. 
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(Cont’d) 

Parameter Setting Range Restriction 

Number of Super Frames 1 to 384 The upper setting limit varies depending on 
the Select Option and Mode settings. 
(Refer to the description about Number of 
Super Frames in Section 5.1.2 “Parameter 
details”.) 

In-depth Symbol 
Interleaver 

ON, OFF Fixed to OFF when System is set to DVB-T, 
Mode is set to 8K, or Inner Interleaver is 
set to OFF. 

Time Slicing ON, OFF Fixed to OFF when System is set to DVB-T.
Cannot be set for LP when Transmission is 
set to Non-hierarchical. 

MPE-FEC ON, OFF Fixed to OFF when System is set to DVB-T.
Cannot be set for LP when Transmission is 
set to Non-hierarchical. 

Filter None, Nyquist, Root 
Nyquist, Gaussian, Ideal 
Lowpass 

 

Roll Off/BT 0.100 to 1.000 Disabled when Filter is set to None or Ideal 
Lowpass. 

Symbol Length 1 to 1023 Disabled when Filter is set to None or Ideal 
Lowpass. 
Fixed to 1 when Filter is set to None. 
Fixed to 1023 when Filter is set to Ideal 
Lowpass. 

Multipath OFF, P1, F1  
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